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Directory structure of the CD-ROM
The CD-ROM contains all the files needed to install the ARM Developer Suite (ADS) version 1.0.1 onto a
PC workstation. The CD-ROM conforms to Microsoft Joliet format. It contains the following directories and
files:
Windows installation files
\
The root directory contains PC hosting of tools for Windows NT,
Windows 95, and Windows 98.
\demo
Contains software for the interactive demo of ADS.
Documentation directory
\PDF
Contains the ADS 1.0.1 documentation in Adobe PDF format.
\HTML
Contains the RogueWave C++ library documentation in HTML
format.
License management
\flexlm
Contains license management tools.
\licenses
Contains license package file.
Application sources
\apps_lib
Contains library source code for specialized math routines and
Digital Signal Processing (DSP).
\Examples
Contains source code for example projects.
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Installing ARM Developer Suite (ADS) 1.0.1
This section describes how to install ADS 1.0.1 in a Windows environment.

2.1

Hardware requirements
The following are the minimum hardware requirements for installing and running ADS 1.0.1:
•
Pentium or higher IBM-compatible PC running Windows 95, 98, 2000, or NT 4
•
32MB RAM
•
75MB Disk space (for a minimum install)
•
CD-ROM drive. This can be a networked CD-ROM drive.

2.2

Software requirements
You must have one of the following operating systems to install and run ADS 1.0.1:
•
Windows NT version 4 or higher
•
Windows 2000
•
Windows 98
•
Windows 95.
If you want to view the PDF versions of the online manuals and specifications you must have Adobe Acrobat
Reader installed. Acrobat Reader is provided with ADS 1.0.1. The online manuals are also viewable in
Dynatext. (The Dynatext viewer is installed during the ADS installation.)

2.3

Installing ADS 1.0.1
To install ADS 1.0.1:
1. Insert the CD into the CD-ROM drive.
The autorun demo program starts.
2. Click the Install button in the demo. (If the autorun demo does not start, execute the setup.exe
program in the top-level directory of the CD-ROM).
3. If you have an earlier version of ADS on your PC, the installation prompts:
Do you want to upgrade your existing installation?
Click the Yes button to continue.
4. When the Welcome window is displayed, click Next. The license agreement window is displayed.
To continue the installation process, you must accept the terms of the license agreement. Installation
of ADS 1.0.1 means that you accept the terms of the ARM License Agreement.
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6.

7.
8.
9.

Click Yes to install the software.
If you do not want to accept the terms of the ARM license click No. If you do not want to accept the
terms of the ARM License you must not use ADS 1.0.1 and you should return the software to the point
of supply for a refund.
If you accept the license agreement, the installer asks you to select a destination directory for your
installation. If you want to accept the default destination, click Next. If you do not want to accept the
default destination, click the Browse button to select the directory where you want the ARM Developer
Suite to be installed.
The Windows installer allows a choice of setup type, each implying a different set of components to be
installed. If you select Custom as the type, it offers a choice of product components to install. If you
select more components than you have room for on your disk, an error message is displayed.
A series of dialogs are displayed giving you a choice for the program folder, CodeWarrior IDE file
associations, and Apps Lib directory (if installed). Accept the defaults or enter a new value.
The installer displays the list of the settings chosen for this installation.
Click Next to start the installation, or click Back to change your settings. After the software is copied to
your disk, the License Installation Wizard is displayed.
ADS is license managed. Use the License Installation Wizard to install a temporary license. See
Installing a temporary license on page 5 for more information.
Install the OCX drivers if required. The Windows installer automatically registers the OCXs that are
required for the CodeWarrior IDE and AXD. As part of this registration, a new version of
comctl32.dll is installed if required. You must reboot your workstation before it can be used.
The installer offers a reboot option at the end of the installation process, if required.
Installation of the ADS software is now complete.
You can view the online documentation in Dynatext or PDF form. See Viewing online documentation on
page 7.
Note
Important additional information about this release is available in the readme.txt file in the ADS 1.0.1
installation directory.
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2.4

Reinstalling ADS 1.0.1
You can use the Windows installer to add extra components to an existing installation. The installer warns
you that an installation already exists on your machine. If you want to install new components or reinstall
existing components, continue with the installation. The installer does not warn you on a component by
component basis that it is overwriting existing software.

2.5

Uninstalling ADS 1.0.1
To uninstall, either use the Add/Remove Programs control panel and select ARM Developer Suite or select
the Uninstall item from the ARM Developer Suite program group. If extra components were added to an
installation by re-running the installer, they are also uninstalled. If you added extra files to the installation
yourself (for example, by compiling the example programs) these are not uninstalled, but you can remove
them manually.
Note
Uninstalling ADS does not remove the ADS binary directory from your PATH.
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Licensed software
You need a license file to run ADS 1.0.1 components. ARM licensed software is license-managed using the
FLEXlm license manager. This prevents you from running ADS until you have obtained a valid license file
from ARM Limited. The License Installation Wizard is displayed during the initial installation. You can also
run the Wizard separately to install or modify your license file.

3.1

Installing a temporary license
You can install a temporary license to get you working quickly while you are waiting for the full license:
1. Select License Installation Wizard from ARM Developer Suite in the program menu. A dialog is
displayed which allows you to install a license file. (If you installed ADS into a different program folder,
the wizard is located in that folder.)
2. Click Install Temporary License.
Your temporary license is printed on a label that is stuck to the box containing the ARM Developer Suite
software. The label contains a license number of the form:
armlmd-ads-xxxxx-xxxxx-xxxxx-xxxxx-xxxxx-xxxxx-xxxx
where each x represents a number.
3. Type the temporary license number into the entry field, exactly as it appears on the box. Do not add any
extra spaces, and include the minus (-) characters.
4. Click Install Temp.
5. Click Close.The license is now installed, and you can use the ARM Developer Suite while you are
waiting for your full license.
This is a temporary license that lasts for a maximum of 45 days. You must follow the instructions in
Generating a license request for a node-locked license to get a full license from ARM.

3.2

Generating a license request for a node-locked license
A node-locked license requires a license file for the PC where the software is installed. Floating-licenses
require a license file on a server. If you are using a floating license, contact your system administrator and
request a license for the server.
If you are installing the node-locked license, use the Generate License Request box to gather the
information required by ARM for a full license file:
1. Select License Installation Wizard from ARM Developer Suite in the program menu. A dialog is
displayed which allows you to install a license file.
2. Click Generate. A new dialog box is displayed.
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3.3

Enter all of your details into the fields on this new window then click Generate Request.
The License Wizard produces a file called license-request.txt in the top-level directory where
you installed the ARM Developer Suite.
E-mail or fax this file to one of the email addresses or fax numbers given in the file. Your full license file
will be returned to you within two working days.
Please ensure that your email program sends this file as ASCII text, and not as HTML.
Click the Close button.

Installing a permanent node-locked license
When you receive your license file, you must run the license management software to install the full license:
1. Save the license file to disk as an ASCII text file.
2. Select License Installation Wizard from ARM Developer Suite in the program menu. A dialog is
displayed to enable you to install a license file.
3. Identify the path and filename of the license file by either:
•
Entering the name of the disk file into the entry field next to the Install Full button.
•
Clicking the Browse button and browsing until you find the file on disk, then clicking Open to copy
the filename into the entry field.
4. Click Install Full. The license wizard takes the full license file and installs it so that you can use the
product.
5. Click Close.
For additional information on how to install your license file, and how to run the license manager software,
refer to:
•
the license wizard help text displayed when you select License Installation Wizard from the program
menu
•
the ARM Developer Suite Getting Started Guide
•
the PDF file enduser.pdf in the flexlm subdirectory of the installation CD.

3.4

Installing a permanent floating license
The system administrator must run the license installation software to install the full license on the server.
Follow the instructions in the ARM Developer Suite Getting Started Guide.
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Viewing online documentation
ADS provides comprehensive online help. In addition, it provides online versions of the printed manuals in
both Dynatext and PDF formats.

4.1

Online help
ADS 1.0.1 provides the following online help.
Context-sensitive help
Context-sensitive help is available for the GUI components of ADS. With ADS 1.0.1 running, position the
cursor on any field or button for which you need help and press the F1 key on the keyboard. If relevant online
help is available, it is displayed.
An alternative method of invoking context-sensitive help is to click on the question mark tool in the toolbar,
then click on the field or button for which you need help.
Viewing online help
The Help menu is available in the menu bar when you run any of the ADS GUI components. Select
Contents from the Help menu to display the main help topics.
You can navigate to a specific page of help in any one of the following ways:
•
From the Contents tab of the Help Topics screen, do any of the following:
— click on a main topic to select it
— click on the Open button
— click on a sub-topic.
•
From the Contents tab of the Help Topics screen either:
— double-click on a main topic book to open it (single-clicking toggles status)
— click on a sub-topic.
•
From the Index tab of the Help Topics screen, do any of the following:
— type the first few characters of a likely index entry
— scroll down the displayed list of index entries until the entry you want is visible
— click on the required index entry.
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•

•

From the Find tab of the Help Topics screen, do any of the following:
— follow the Find Setup Wizard instructions to create a full text search file
— type or select key words that may occur anywhere in the help text
— select a topic from the displayed list of topics that contain the specified words.
From any other page of help that has a hypertext link to the page you want, click on the highlighted
hypertext link. Most pages of online help contain help links that you can click:
— highlighted hotspots with dashed underlining display brief explanations in pop-up boxes
— highlighted hotspots with solid underlining jump to other related pages of help
— browse buttons display related pages of help.

4.2

Dynatext
The manuals for ADS 1.0.1 are provided as Dynatext electronic books. The books and the Dynatext viewer
are installed if you selected this option during installation. The manuals are installed by default in a Typical
or a Full installation.
Viewing the manuals
To display the online documentation, either:
•
select Online Books from ARM Developer Suite v1.0.1 in the program menu.
•
execute install_directory\dtext41\bin\dtext.exe

4.3

Adobe Acrobat Reader
The manuals for ADS 1.0.1 are also provided on the CD-ROM in Acrobat Portable Document Format (PDF)
files. You must have a copy of Adobe Acrobat Reader installed before you can view them. Acrobat Reader
is supplied with ADS 1.0.1 and is also available from the Adobe web site http://www.adobe.com.
If you have installed the PDF documentation, it is in the install_directory\PDF directory. If you want
to install the PDF documentation later, drag the contents of the \PDF directory on the CD-ROM to an
appropriate directory on your local drive. (If you do not already have the Acrobat Reader installed, install
the reader by executing acroread.exe in the top-level directory of the CD-ROM.)
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Viewing the manuals
To consult the manuals:
1. Start Adobe Acrobat Reader. (If you do not already have the Acrobat Reader installed, install the reader
by executing acroread.exe in the top-level directory of the CD-ROM.)
2. Select Open... from the File menu.
3. If you have installed the PDF versions of the online documentation, move to
install_directory\PDF.
If you have not installed the PDF files, you can view the files directly from the \PDF directory on the
CD-ROM.
4. Open the PDF files you want to view.
For more information on using Adobe Acrobat Reader, select Reader Help from the Help menu.

4.4

HTML
The manuals for the RogueWave C++ library for ADS 1.0.1 are provided on the CD-ROM in HTML files. Use
your web browser software to view these files.
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Feedback
This section describes how to report problems and comments on ARM ADS 1.0.1 and its documentation.

5.1

ADS 1.0.1
If you have feedback on ADS 1.0.1, please contact your supplier.
To help us to provide a rapid and useful response, please give:
•
details of the release you are using, such as the version number
•
details of the platform you are running on, such as your hardware platform, operating system type and
version
•
a small stand-alone sample of code that reproduces the problem
•
a clear explanation of what you expected to happen, and what actually happened
•
the commands you used (including any command-line options)
•
sample output illustrating the problem
•
the version string of the tool (including the version number and date).

5.2

Feedback on the documentation
If you have problems with the ADS 1.0.1 documentation, please send email to errata@arm.com giving:
•
the document title
•
the document number
•
the page number(s) to which your comments refer
•
a concise explanation of the problem.
General suggestions for additions and improvements are also welcome.
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